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About This Guide

This guide is designed to help you get up and running quickly with 
FastTrack Schedule 10 by introducing you to the program interface,
giving you a five step process to follow as you create a project 
schedule and explaining the available program columns included in 
your schedule.

For additional information about the program, you can access 
FastTrack Schedule’s built-in Help anytime FastTrack Schedule is 
running or visit www.aecsoftware.com for program support.

Installing and Activating FastTrack Schedule 10 

System Requirements

Windows System Requirements:
• Microsoft Windows XP (SP3), Windows Vista (SP1), Windows 7
• 500 MHz processor or higher
• 256MB of RAM
• 150MB of free hard disk space
• 1024x768 or higher screen resolution

Macintosh System Requirements:
• Mac OS X v10.5.8 Leopard or later, v10.6 Snow Leopard
• 867 MHz or faster Intel, PowerPC G5, or PowerPC G4 processor
• 512MB of RAM
• 150MB free hard disk space
• 1024x768 or higher screen resolution

Installing from a CD

Installing for Microsoft Windows XP (SP3), Windows Vista (SP1), 
Windows 7 from a CD:

1. Insert the FastTrack Schedule CD-ROM into the CD-ROM drive.
2. Wait for a dialog to appear.
3. Click the Install button.
4. Follow the instructions on screen.

Installing for Macintosh from a CD:
1. Insert the FastTrack Schedule CD-ROM into the CD-ROM drive.
2. Double-click the FastTrack Schedule Installer icon.
3. Follow the instructions on screen.

About This Guide Installing and Activating FastTrack Schedule 10
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Important:
If you have to reinstall, make sure all the FastTrack Schedule data 
files that you have created have been moved or copied to a dif-
ferent folder before you erase the previously installed version of 
FastTrack Schedule. Once you delete a file, it may not be possible 
to restore the file. Consult your operating system documentation 
for more information about deleting and restoring files.

Installing from a download

Installing for Microsoft Windows XP (SP3), Windows Vista (SP1), 
Windows 7 from a Download:

1. Download the FastTrack Schedule 10 Installer.
2. Double click the downloaded file.
3. Follow the instructions on screen.

Installing For Macintosh from a Download:
1. Download the FastTrack Schedule 10 Install disk image, and 

mount it. Most browsers mount the disk image automatically at 
the end of the download.

2. Double-click the FastTrack Schedule Installer icon.
3. Follow the instructions on screen.

Activating the program

When you first launch FastTrack Schedule 10, you will be prompted 
to enter a license key to activate your product. Your license key will 
be provided in the purchase confirmation email, or with the material 
delivered to you with a physical box and CD version of the product.

Upgrading from a previous version

To upgrade from FastTrack Schedule 9 or FastTrack Schedule 8, 
please download the FastTrack Schedule 10 installer and follow the 
instructions above.

Program Overview

FastTrack Schedule is a project management solution that simplifies 
the planning, tracking and management of your projects. FastTrack 
Schedule is a powerful, easy to use, all-purpose tool for tracking all 
your project’s activities, tasks, resources, to-do lists, and deadlines 
and sharing and consolidating schedules with your team. 

There are three Views in which to manage your data in FastTrack 
Schedule.

The Schedule View
This is the primary View of FastTrack Schedule; all other Views 
support the Schedule View. It is in this View that you enter activi-
ties; draw activity bars along a timeline; link bars; view critical paths; 
track the Scheduled, Revised and Actual dates and times of tasks in 
your schedule; insert pictures, text boxes, and legends; and create 
and view summary graphs.

Installing and Activating FastTrack Schedule 10 Program Overview
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The Calendar View
The Calendar View displays information from the Schedule View in 
the traditional look of a wall calendar. This allows you to view time 
vertically rather than horizontally, as you do in the Schedule and 
Resource Views. You can view and print completely customizable 
calendars that can be filtered to display only those activities you want 
to see. You can also create a calendar of any number of contiguous 
weeks, not just a full month.

In the Calendar View you can draw bars; move bars; hide bars; filter 
activities to view only those bars you want to see; edit Scheduled, 
Revised and Actual dates and times; apply ranges and FastSteps; and 
print the calendar in current, monthly, and custom configurations.

The Resource View
In this View you track and manage the use of resources in your 
project. You can see exactly to which tasks your resources are 
assigned, what percentage of their total available time is being used, 
and how many hours they are working in a given unit of time.

In this View, you can create and edit resources, contact details, rates, 
and resource work calendars; you can also move bars in the timeline, 
and change the Scheduled, Revised and Actual dates of tasks. Until 
you assign the resources you have created to a task in the Schedule 
View, no bars will appear in the Resource View.

Program Overview Program Overview
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Two Windows Interfaces

The Ribbon Bar

The ribbon bar interface replaces menus with tabs. From each tab 
you can access grouped controls that allow you to perform all the 
program functions. In FastTrack Schedule the View group, from 
which you can switch between the three program views, is available 
on every tab. There is only one menu, the Application menu.

Application Menu

1. Application Button - displays the application menu which lists 
controls used to perform actions on the entire document.

2. New - opens the Getting Started dialog.
3. Open - open an existing FastTrack Schedule file.
4. Import - import data, iCalendar files and MindJet MindManager 

files.
5. Save - saves the file to its existing location.
6. Save As - save the active file with a new name or to a new loca-

tion or as a template.
7. Print - print the open View, open the Print Preview window, set 

print and page options.
8. Prepare - open the Properties dialog and set password restric-

tions for the active file.
9. Send To - sends the active file as an attachment or as a picture 

in an email.
10. Publish - publish a file to an iCalendar server, unpublish an 

iCalendar file, view the publish log.
11. Export - export the active file as data, HTML, an mpx file, a 

Microsoft Project XML file, an iCalendar file, a MindJet Mind-
Manager file or a picture.

12. Close - close the active file or close the Print Preview window.
13. Application Options - set options for FastTrack Schedule.
14. Document Options - set options for the active file.
15. Exit FastTrack Schedule - closes the program and all active 

FastTrack Schedule files.
16. Recent Documents - view a list of all recently opened files.
17. Quick Access Toolbar - always visible, click the icons in this 

toolbar to quickly save, undo, redo, open existing schedules, 
open new schedules, and open the Print Preview window.

Two Windows Interfaces Two Windows Interfaces
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Home Tab

1. Views Group - switch between the Schedule, Calendar and Re-
source Views. This group is available on every tab of the Ribbon 
interface.

2. Clipboard Group - cut, copy and paste selected items.
3. Font Group - edit font name, size, color, appearance and align-

ment of text.
4. Outline - indent, outdent, show, hide and view activity outline 

levels.
5. Tools Group - is discussed in detail on page 17.
6. Link Group - create and remove dependencies.
7. Bar Styles Group - select and edit bar styles.
8. Editing Group - find and replace text, go to Today’s date or a 

specific bar or row, hide, show or select all.
9. Timeline Range Group - determine the visible window of time in 

the timeline graph

Insert Tab

1. Rows & Columns Group - insert new rows or columns into your 
schedule.

2. Timeline Elements Group - insert text boxes, legends, pictures, 
pointers and objects into your schedule. Add, edit or remove 
Summary Graphs, Timescale rows and Datelines.

3. Page Group - insert Headers and Footers to the printed docu-
ment and page breaks to the selected row.

Format Tab

1. Display Group - open the format dialogs to determine the 
display of: bar styles, the critical path, links, datelines, gridlines, 
headers and footers and selected items.

Two Windows Interfaces Two Windows Interfaces
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View Tab

1. Show/Hide Group - show or hide action columns, summary 
bars, datelines, links, critical paths and the alignment grid.

2. Resources Group - show or hide the Percent Work Usage, Work 
Usage and Assignments summary rows for resources. Percent 
Work Usage is the only resource summary row that can display 
in the Schedule View. No summary graphs can display in the 
Calendar View.

Project Tab

1. Details Group - open information forms to edit data regarding: 
the overall project setting, activities and resources. Open and 
edit multiple work calendars and define a WBS (work  
breakdown structure) to establish a hierarchy of tasks.

2. Timeline Group - quickly set the timeline range to show all bars 
in the schedule. Define, edit and select ranges of time to view 
in the timeline. Change the units in which you view time in the 
schedule.

3. Layout Group - define, edit and select schedule layouts.

4. Sort & Filter Group - define, edit and select sorts and filters 
to view a specific subset of data in your schedule. Restore the 
order of sorted data and unhide any data hidden by a filter.

Tools Tab

1. Proofing Group - correct spelling in the entire open View or 
specified parts of the schedule. Set the spelling options.

2. Macro Group - create, edit and run FastSteps scripts.
3. Consolidation Group - determine the files to consolidate and 

define the parameters of the consolidation. Update data in files 
you’ve consolidated.

4. Tracking Group - define and edit baseline, revised and actual 
activity dates and times. See how your custom column names 
map to their original program-defined names.

5. Shift Group - shift items or the whole schedule backwards or 
forwards in time.

6. Arrange Group - arrange overlapping items, set snap to grid, 
and column, row and typing autofit options.

Application Tab

1. Product Group - access helpful websites and open the 
program’s About dialog.

Two Windows Interfaces Two Windows Interfaces
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2. Help Group - get help using the program with tutorials, 
example files and keyboard shortcuts.

3. Workspace Group - manage the look and feel of your 
workspace, and switch your theme from Ribbon Bar to Classic  
Menu Bar.

4. Window Group - determine how multiple open FastTrack 
Schedule windows will display.

The Classic Menu Bar Interface

1. Standard Toolbar - open new and existing FastTrack Schedule 
files, save print, open Print Preview, check spelling and format 
the selected item.

2. Outline Toolbar - indent, outdent, show, hide and view activity 
outline levels.

3. Layouts Toolbar - define, edit and select schedule layouts.
4. Filter and Sorts Toolbar - define, edit and select sorts and filters 

to view a specific subset of data in your schedule. Restore the 
order of sorted data and unhide any data hidden by a filter.

5. Fonts Toolbar - edit font name, size, color, appearance and 
alignment of text.

6. Views Toolbar - switch between the Schedule, Calendar and 
Resource Views.

7. Tools Toolbar - is discussed in detail on page 17.
8. Link Toolbar - create and remove dependencies.
9. Bar Styles Toolbar - select and edit bar styles.

10. Timeline Range Toolbar - quickly set the timeline range to show 
all bars in the schedule. Define, edit and select ranges of time to 
view in the timeline. Change the units in which you view time in 
the schedule.

Switching Between Windows Interfaces

To switch from the Ribbon Bar to the Classic Menu Bar interface:
1. Save changes to all open FastTrack Schedule files.
2. On the Application tab, in the Workspace group, click the 

Themes button and select Classic Menu Bar from the  
dropdown list.

3. Click OK when prompted and relaunch FastTrack Schedule 10.
4. Exit the program then relaunch FastTrack Schedule 10. You will 

now see the Classic Menu Bar interface.

To switch from the Classic Menu Bar to the Ribbon Bar interface:
1. Save changes to all open FastTrack Schedule files.
2. In the View menu, select. Themes and choose Ribbon Bar.
3. Click OK when prompted and restart FastTrack Schedule 10.
4. Exit the program then relaunch FastTrack Schedule 10. You will 

now see the Ribbon Bar interface.

Two Windows Interfaces Two Windows Interfaces
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Macintosh Interface

1. Views - switch between the Schedule, Calendar and Resource Views. 
2. Print Preview - opens the Print Preview drawing layer.
3. Layouts - define, edit and select schedule layouts.
4. Filters - define, edit and select filters to view a specific subset of 

data in your schedule.
5. Sorts - define, edit and select sorts to view data in a specified order.
6. Ranges - set, define, edit and select ranges of time to view
7. FastSteps - create, edit and run FastSteps scripts.
8. Format Selected - opens the format dialog for the selected item.
9. All Bars - quickly set the timeline range to show all bars in the 

schedule.
10. Timeline Units - quickly change the units in which you view 

time in the schedule.
11. Resource % Work Usage - view or hide a summary graph showing 

how much of a resource’s work time is allocated to a selected activity 
12. iMedia - opens the iMedia browser from which you can access 

images on your computer and bookmarked websites.
13. Color - adjust the color of selected items.
14. Fonts - edit the appearance of text.
15. Format Bar - holds frequently used controls for ease of access.
16. Tools controls - discussed in detail on page 17.
17. Link controls - create and remove dependencies.
18. Outline controls - indent, outdent, show, hide and view activity 

outline levels.
19. Bar Styles controls - select and edit bar styles.
20. Font controls - edit size, color, appearance, and alignment of text.
21. Timeline Range controls - determine the visible window of time 

in the timeline graph.

The Tools

There are six tools that are essential to using FastTrack Schedule.

  

The Arrow tool is the general-purpose tool that selects, 
moves, and resizes items in all Views. When you want to 
drag an activity bar, row, column or graphic item this is 
the tool you need to have selected.

The Bar Tool draws activity bars in the timeline graph.

The Link Bar tool lets you drag and draw links between 
bars to create dependencies.

The Revise tool changes the activity’s Revised start and/
or finish dates, times, and durations.

The % tool defines the percent complete and Actual 
start, finish, and duration of an activity.

The Text Box tool draws and edits text boxes for use as 
labels and titles.

  

Please note:
Unless a tool is locked, the default setting for each tool 
is to revert back to the Arrow tool after use. You can 
lock a tool down so that it can be used multiple times. 
To lock a tool, on Windows, on the Home tab, select 
the Lock Tool option in the Tools group, on Macintosh, 
double-click the tool.

Drawing an activity bar with the Bars tool changes the 
bar’s default Constraint Type from the recommended 
“As Soon As Possible” to “Start On or After”.

Macintosh Interface The Tools
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Creating a Schedule

There are several ways to schedule your projects using FastTrack 
Schedule, but the five steps below are the recommended approach 
to creating a new schedule. 

 1.   Set a Project Start Date:

This step is very important as all the baseline, revised and actual 
dates in your schedule will be derived from this date. If you do 
not enter a specific Project Start Date the program will use the 
first available work date and time in relation to the date you cre-
ated the file i.e. “today’s” date.

To set the Project Start Date and Time in the Windows Ribbon:
1. On the Project tab, in the Details group, click Project Information.
2. In the Project Information dialog, determine the Start Date 

in relation to which you would like each item in the project 
to be scheduled.

  

To set the Project Start Date and Time in the Mac and 
Windows Classic Menu:
1. From the Project menu, select Project Information.
2. In the Project Information dialog, determine the Start Date 

in relation to which you would like each item in the project 
to be scheduled.

 2. Determine Project Work Calendar

The Work Calendar is where you define what hours of what 
days are work hours and thus applied towards the completion 
of a task. Each resource in your project will have its own Work 
Calendar and you can set options to decide how you handle 
conflicts between a resource’s Work Calendar and the Work 
Calendar of the project as a whole.

To determine the Project Work Calendar in the Windows Ribbon:
1. On the Project tab, in the Details group, click Work Calendars. 
2. In the Work Calendars dialog, determine which days are 

exception/non-work days (vacation, holiday, leave, etc.).  
The dates will affect how your tasks are calculated and 
displayed.

Creating a Schedule Creating a Schedule
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To determine the Project Work Calendar in the Mac and 
Windows Classic Menu Bar:
1. From the Project menu, select Work Calendars.
2. In the Work Calendars dialog, determine which days are 

exception/non-work days (vacation, holiday, leave, etc.).  
The dates will affect how your tasks are calculated and 
displayed.

 3. Create Task List

Use FastTrack Schedule to create an outline of every task in 
your project. You can add, delete and move rows as you design 
your project.

1. Click in the first empty cell in Row 1 and enter your project name
2. In Row 2, hit Tab to indent, and begin entering your Activities.
3. As you enter Activities, consider what the smallest amount of 

work is that you can accurately measure. Traditionally, tasks 
would be no smaller than 4 hours. 

4. If appropriate, enter sub-tasks that are part of your small-
est measurable work package, as shown in Rows 5 - 9 in the 
graphic above. 

5. Don’t forget to add a task that references completion of the 
project. 

 4. Determine Task Durations

Before you begin entering durations, determine the units of time 
in which you would like to calculate an activity’s duration. In this 
example, we are using the default unit of Days.

To change the duration units in the Windows Ribbon Bar:
Open the Application menu and click the Documents Options 
button found at the bottom of the menu window.
To change the duration units in the Windows Classic Menu Bar:
From the Tools menu, select Document Options. 
To change the duration units in Macintosh menu:
From the FastTrack Schedule 10 menu, select Document Preferences.

In the Project tab of the Document Options/Preferences dialog, 
select either Hours, Days, Weeks, Months, Quarters or Years 
from the Duration Units drop-down list.

Enter durations in the rows that are on the deepest outline level 
for a task. Do not enter any duration data in Summary Rows, 
such as Rows 1, 5 and 7 in the graphic above. These durations 
will be calculated automatically from the durations of tasks in a 
deeper outline level.

Before you enter duration data for an activity such as ‘End of 
Project’ as shown in Row 12 of the graphic, choose a milestone 
from the bar style options. Once you’ve selected the milestone, 

Creating a Schedule Creating a Schedule
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enter a duration time of ‘0,’ as a milestone is a target date and 
has no duration.

 5. Create Task Dependencies

Linking activity bars creates dependencies whereby, if the dates 
of one activity change, all dependent activities’ dates change 
according to the parameters you set.

1. Create dependencies by selecting Rows 1 - 12. To select 
multiple rows, select the first row of the collection of rows 
you want to select, in this instance Row 1. Hold down the 
Shift key and select the last row of the collection of rows 
you want to select, in this instance Row 12.

2. Once selected, click the Link control. 
3. The default dependency type is ‘Finish to Start’. The default 

constraint type is ‘As Soon As Possible’. To change any of 
your task dependency or constraint types, double-click the 
pertinent bar to open the Information Form for that Activ-
ity. In the Tracking tab of the Information Form, select the 
desired Constraint Type. In the Links tab, select the desired 
Link Type.

Create Unique Presentation Quality Schedules

Encourage your team members to indulge their creativity. FastTrack 
Schedule stands out for the ease with which you can create eye-
catching, presentation quality schedules. Virtually every item in your 
schedule can be customized. Make sure to add the following items 
to the timeline:

1. graphics for custom bars and milestones
2. image columns
3. pictures
4. text boxes
5. legends
6. bar labels
7. summary graphs

You can also shade rows and columns in and out of the timeline, and 
resize column and row sizes.

 

Creating a Schedule Create Unique Presentation Quality Schedules
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Helpful Links

General FastTrack Schedule 10 Information
http://www.fasttrackschedule.com

Support Programs
http://www.aecsoftware.com/support/programs/

Training & Consulting Services
http://www.aecsoftware.com/services/training/

Templates
http://www.aecsoftware.com/downloads/templates/

Online Store
http://www.aecsoftware.com/purchase/store/

Customer Service
http://www.aecsoftware.com/purchase/customerservice/

Available Schedule View Columns

COLUMN NAME TYPE DESCRIPTION

% Complete Number Percentage of activity com-
plete

% Used NUMBER Percentage of a resource’s 
time used

Activity Name TEXT Project tasks/activities

Activity Row ID ID/CODE ID to identify row

Activity Row 
Number

ID/CODE Number to identify row

Actual Duration DURATION Duration of time it actu-
ally took an activity to be 
completed

Actual Finish Date DATE Date on which an activity 
actually finished

Actual Finish Time TIME Time activity actually fin-
ished

Actual Start Date DATE Date activity actually started

Actual Start Time TIME Time activity actually started

Attendees TEXT iCal/Outlook event attend-
ees

Bar ID ID/CODE Unique identifier for bar

Bar Row ID ID/CODE Unique identifier for bar row

Baseline Cost 
1 - 10

COST Capture activity costs at up 
to 10 points in time for the 
lifetime of the project

Helpful Links Available Schedule View Columns
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COLUMN NAME TYPE DESCRIPTION

Baseline Duration 
1 - 10

DURATION Capture activity durations 
at up to 10 points in time for 
the lifetime of the project

Baseline Finish 
Date 1 - 10

DATE Capture activity finish dates 
at up to 10 points in time for 
the lifetime of the project

Baseline Finish 
Time 1 - 10

TIME Capture activity finish times 

Baseline Start 
Date 1 - 10

DATE Capture activity start dates 

Baseline Start 
Time 1 - 10

TIME Capture activity start times 

Baseline Work 
1 - 10

WORK Capture activity work 

Calculation 1 - 100 CALCULA-
TION

Define a formula to calculate 
data from the schedule

Constraint Date DATE Date to be used with  
constraint type

Constraint Time TIME Time to be used with  
constraint type and date

Constraint Type ID/CODE Parameter applied to activity 
to control its behavior as 
project changes

Cost 1 - 10 COST Formatted to display mon-
etary values

Critical FLAG Yes/No - Yes indicates that 
the activity is on the critical 
path

Date 1 - 10 DATE Formatted to display dates

COLUMN NAME TYPE DESCRIPTION

Duration 1 - 10 DURATION Formatted to display dura-
tions

Early Finish Date DATE Earliest date activity can 
finish

Early Finish Time TIME Earliest time on Early Finish 
Date activity can finish

Early Start Date DATE Earliest date activity can 
start

Early Start Time TIME Earliest time on Early Start 
Date activity can start

Effort Driven FLAG Yes/No - Yes indicates that 
the activity's duration is 
driven by resource effort

Finish Date DATE Originally estimated finish 
date "Scheduled"

Finish Date 1 - 10 DATE Formatted to display dates

Finish Float DURATION Number of days activity's 
finish date can slip before 
project finish date is affected

Finish Time TIME Originally estimated finish 
time "Scheduled"

Finish Time 1 - 10 TIME Formatted to display time

Fixed Cost COST Lump sum costs for the ac-
tivity, feeds into Total Cost

Fixed Duration FLAG Yes/No - Yes indicates that 
the activity's duration is 
fixed and not recalculated 
automatically

Available Schedule View Columns Available Schedule View Columns
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COLUMN NAME TYPE DESCRIPTION

Flag 1 - 20 FLAG Formatted to display Yes/
No option

Free Float DURATION Number of days an activity 
can slip before next activity 
is affected

Hyperlink 1 - 10 HYPERLINK Formatted to display hyper-
link items - email address, 
URL, file

Ignore Resource 
Calendars

FLAG Yes/No - Yes indicates that 
the activity is to ignore the 
assigned resource's calendar

Image 1 - 10 IMAGE Formatted to display images

Late Finish Date DATE Latest date an activity can 
finish before project finish 
date is affected

Late Finish Time TIME Latest time on Late Finish 
Date an activity can finish 
before project finish date is 
affected

Late Start Date DATE Latest date an activity can 
start before project finish 
date is affected

Late Start Time TIME Latest time on Late Start 
Date an activity can start 
before project finish date is 
affected

Location TEXT iCal/Outlook event location

COLUMN NAME TYPE DESCRIPTION

Notes TEXT When text is entered, a 
notes indicator appears in 
the Information Form action 
column

Number 1 - 50 NUMBER Customizable to display 
numerical values

Parent Tree ID/CODE Activity name complete with 
parent rows, when using 
outline levels

Predecessors ID/CODE Displays which activity 
row(s) an activity is depen-
dent on, including link type 
and lag

Priority ID/CODE Number field to prioritize 
your tasks

Resource Cost COST Pre-defined calculation of 
the assigned resource’s rate 
x work

Resources As-
signed

ID/CODE Linked to Resource View; 
defines assigned resources 
to activity

Revised Duration DURATION Revision to activity's sched-
uled duration

Revised Finish 
Date

DATE Revision to activity's sched-
uled finish date

Revised Finish 
Time

TIME Revision to activity's sched-
uled finish time

Revised Start Date DATE Revision to activity's sched-
uled start date

Available Schedule View Columns Available Schedule View Columns
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COLUMN NAME TYPE DESCRIPTION

Revised Start Time TIME Revision to activity's sched-
uled start time

Start Date DATE Originally estimated start 
date "Scheduled"

Start Date 1 - 10 DATE Formatted to display dates

Start Float DURATION Number of days activity's 
start date can slip before 
project finish date is affected

Start Time TIME Originally estimated start 
time "Scheduled"

Start Time 1 - 10 TIME Formatted to display time

Status ID/CODE Automatically calculated, 
based on % Complete, % 
Used and Current Dateline

Subproject Activ-
ity Row ID

ID/CODE In a consolidated file, dis-
plays the original Row ID of 
activities in a subproject.

Subproject WBS ID/CODE In a consolidated file, dis-
plays the original numerical 
hierarchy of activities in a 
subproject based on their 
outline levels before consoli-
dation.

Successors ID/CODE Displays which activity rows 
are dependent on what other 
activity rows, including link 
type and lag

COLUMN NAME TYPE DESCRIPTION

Task Calendar ID/CODE Assign/Edit an activity’s 
calendar (Standard, 24 hour, 
Nightshift, etc.)

Text 1 - 100 TEXT Customizable to display text 
data

Time 1 - 10 TIME Formatted to display time

Total Cost COST Pre-defined calculation of 
Fixed Cost + Resource Cost

Total Float DURATION Number of days activity can 
slip before project finish date 
is affected

Total Resource 
Duration

DURATION The total duration, in hours, 
of resource work time al-
located to an activity.

WBS ID/CODE A numerical hierarchy of 
activities based on outline 
levels.

Work WORK The amount of work hours 
available to be allocated to 
resources.

Available Schedule View Columns
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